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CuAprTER 41

JSF AND VisuAL WEB
DEVELOPMENT

Objectives

B To explain what JSF is (§41.1).
B To create a JSF page using NetBeans (§41.2).

B To use JSF UI components (e.g., Static Text, Text Field, Button, Drop Down List, List
Box, Radio Button Group, Check Box Group, Text Area, Table) (§41.3).

B To use JSF containers Grid Panel, Group Panel, and
Layout Panel to group components (§41.4).

To bind data with JSF UI components (§41.5).
To maintain persistency using session tracking (§41.6).

To validate input using Message components (§41.7).

To improve efficiency using virtual forms (§41.8).
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JSF and Visual Web Development

41.1 Introduction

The use of servlets, introduced in Chapter 39, is the foundation of the Java Web technology. It
is a primitive way to write server-side applications. JSP provides a scripting capability and al-
lows you to embed Java code in HTML. It is easier to develop Web programs using JSP than
servlets. However, JSP has some problems. First, it can be very messy, because it mixes Java
code with HTML. Second, using JSP to develop user interface is tedious. JavaServer Faces
(JSF) comes to rescue. JSF supports visual Web development. You can create a Web user in-
terface using a tool without writing any code. JSF completely separates Web UI from Java
code, so the application developed using JSF is easy to debug and maintain.

A couple of tools support JSF. This chapter demonstrates visual JSF using NetBeans 6.7.
Visual JSF is a plug-in for NetBeans 6.7. To install it, choose Tools, Pluggins, and select
Visual JSF.

41.2 Getting Started with Visual JSF

A simple example will illustrate the basics of developing visual JSF projects using NetBeans.
The example is a server-side application that displays the date and time on the server, as
shown in Figure 41.1.

[ http:/ /localhost:8080/ jstdemo/ - Windows Internet Explo _ ||:|| ll
m' I@ http://localhost: 8080/jsfdemo/ j |2 IGcche Pl-
¢ <%  [Ehttp:/focalhost:8080/jsfdemo/ | H Ty vE) v v dpagev (O Took v

=

Current time on the server is Wed Sep 05 21:09:33 EDT 2007

[

FIGURE 41.1 The application displays the date and time on the server.

Here are the steps to create the application.

1. Choose File > New Project to display the New Project dialog box. In this box, choose
Web in the Categories pane and Web Application in the Projects pane. Click Next to dis-
play the New Web Application dialog box.

2. In the New Web Application dialog box, enter and select the following fields, as shown
in Figure 41.2(a):

Project Name: jsfdemo
Project Location: c:\book
Check Set as Main Project

Click Next to display the dialog box for choosing servers and settings. Select the following
fields as shown in Figure 41.2(b). (Note: Some examples do not work in V3 without mod-
ifications of project files due to bugs in the new version. So, this chapter uses V2.)

Server: GlassFish V2
Java EE Version: Java EE 5

Click Next to display the dialog box for choosing frameworks, as shown in Figure 41.3. Check
Visual Web JavaServer Faces. Click Finish to create the project, as shown in Figure 41.4.

o
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[ ] New Web Application

MNew Web Application

Steps Name and Location
e Pt ProjectName:  |jsfdemg] Setti
2. Name and Location et L | Steps server and ngs
3. Server and Settings Project Location: |C:\pook
4 Frameworks e - - 1 Choose Project Add to Enterprise Application: | </one >
= 2, Name and Location
Project Folder: | C:\bookYsfdemo g
3. Server and Settings 5 . .G\ ssEEh V3
4, Frameworks gerver: |EAaEE .4
[] Use Dedicated Folder for Storing Libraries Use dedicated library folder for server JAR files
Libraries Folder: Browse... )
Java EE Version: JavaEES -
Different users and projects can share the
same compilation libraries (see Help for details). Context Path: | fisfdemo
Set as Main Project i i '
[ <Back ][ Next> Finish Cancel | [ b [ < Back ] [ Next > ] [ Einish I [ Cancel ] [ Help
(a) (b)

FIGURE 41.2 The New Web Application dialog box enables you to create a new Web project.

L ] New Web Application

Steps Frameworks

Choose Project Select the frameworks you want to use in your web application.

MName and Location
Server and Settings Visual Web JavaServer Faces

Frameworks Spring Web MVC 2.5
JavaServer Faces
Struts 1.3.8
Hibernate 3.2.5

MNext = [ Finish ” Cancel ” Help l

FiIGURe 41.3 Checking Visual Web JavaServer Faces creates a visual Web project.

A visual Web project is created with an empty page named Pagel.jsp, as shown in
Figure 41.4. You see Pagel with subtabs in the content pane. The Design tab enables you Design tab
to design the Ul visually. The JSP tab enables you to view and modify the JSP codes. The ISP tab
Java tab enables you to view and modify the Java code. These three tabs are synchronized. Java tab
Whenever you make a change in the Design, the corresponding code in the JSP and Java
will change and vice versa.

The Palette window contains the Ul components that you can drag and drop to the palette window
Design pane.

Tip
There are several windows for a visual Web project. If a window (e.g., the Palette window) is not
displayed, choose an appropriate menu from the Windows menu to display it.

Now you are ready to create a page for displaying the current date and time on the server.
Here are the steps:

1. Rename Pagel.jsp to CurrentTime.jsp. To do so, right-click the context menu on Pagel.jsp
in the Project pane and choose Refactor > Rename to display the Rename dialog box.  renaming files
Enter CurrentTime as the new name and click Refactor to finish renaming.

o
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[_] NetBeans IDE 6.7

File Edit View Mavigate Source Refactor Run Debug Profile Team Tools Window Help

a9

T D@

|Qv| Search (Ctrl+I) |

i Projects <0 % |;Files : Services {3l Page1 =] EDIEE [: patette B ®
= jsfdemo Design | 1P Java | &g @& (i [Any sie = E| Woodstock Basic -
B[ Web Pages ; RN 5] Label =l
Lo WEB-INF L |A] Static Text
| ) resources
: A I S O P U P ] Text Field
@D Page1.jsp
o[ ConfigurationFles — [foecocteeteie it ottt =] Text Area
-\ fg ServerResources L0 0T (] Button
H-lg sourcePackages |} . Design your page by dragging components from the Palette. 00 &3 Hyperlink
i-| f7 Test Packages
braries Image Hyperlink
-l Libraries Define a component's behavior by adding code: Either double-click aae v
k| @ TestLibraries ... ... the component or right-click the component and choose its event handler, . - .. .. .||/=] Drop Down List
}-@ Project Woodstock Themes
t-| jg Component Libraries Page layaout is currently st ta Grid Layaut, which positions : No Properties 0 &
}- Data Source References companents at specific x and v coordinates, IF you would lke
______ to use Flow layout, which positions components left to right and R T —
: Navigator a= top to battar, change the Page Layout property ta Flaw Layaout. o ropErtes
<Mo View Available > 0
& INS

FIGURE 41.4 An empty page is created in a new Visual Web project.

Static Text

fdemo - NetBeans IDE 6.

2. Click to select the Static Text icon from the Palette pane and drop it to the Design pane,

as shown in Figure 41.5. In the id field in the Properties pane for the static text, enter
stCurrentTime to change the id. Whenever you click a component in the Design
pane, its corresponding properties are displayed in the Properties pane. You can view
and modify the component’s properties in the Properties pane.

File Edit View Mavigate Source Refactor Run Debug Profile Team Tools Window Help

MTEE% D¢

TE DB

| Qv | Search (Ctrl+1)

: Projects 4 % | Files

| : Services

B@ jsfdemo

ELJ--I\D Web Pages

L)) WEB-INF

Iy resources

------ 5]|> CurrentTime.jsp
G- | Configuration Files
~| g Server Resources

B f5 Source Packages
(| jg TestPackages
B+l Libraries

- | TestLibraries
[t

G

G

}-@ Project Woodstock Themes
t-| }g Component Libraries
}' Data Source References

! stCurrentTime - Navigator

@ CurrentTime
@ RequestBeani
@ SessionBean1
@ ApplicationBean1

| currentTime * §| LHEHE i Palette 0 =
Design Jsp Java | & B :Any Size v: = Woodstock Basic -
T IR " 15 Label [
o | |A] Static Text
=]
Edit Java Source - [ Text Field
Bind to Data.. [ I;__EITEXtNEE
Add [#] Button
Property Bindings.. |- ... &3 Hyperlink o
............ Add Binding Attribute -~ ||: stcurrenfTime - Properties D ®
............ Edit JSP Source LL. 1. L ||[E General N
id stcurrentTime [L)[2]
............ Edit Text RN | =ree—
I height: 22px;...
Select Parent style aht: 22px; E]
...................... styleClass .
a =
____________ Edit Event Handler B | & -
.......... stCurrentTime 0

SetInitial Focus

Virtual Forms...

staticText1 (StaticText)

Snap to Grid

FIGURE 41.5 A static text is placed in the Design pane.

[ w08 |INS
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3. Right-click on stCurrentTime in the Design pane to display a content menu, as
shown in Figure 41.5. Choose Add Binding Attributes. This step automatically gener-  add binding attributes
ates code that enables you to access stCurrentTime in the Java source code.

4. Click the Java tab in the content pane and enter

stCurrentTime.setText("'Current time on the server is
+ new java.util.Date());

in the prerender method, as shown in Figure 41.6.

[ ] jsfdemo - NetBeans IDE 6.7

File Edit View Navigate Source Refactor Run Debug Profile Team Tools Window Help

IS-FLICE

PP D= | Files | Services Ej CurrentTime * E| @El @ : Palette 0> 2
=@ isfdemo Desion 3¢ [ R E-E- QRSP LB |E2E|0 0| = ||0samplks s
= LD Web Pages WIIL o = T 1T - B UIE lilm |57 Travel: prerende
B[, WEB-INF - [ Database
%ﬁ resources [+ Database First
by CurrentTime.jsp -
3
3 =
- | Configuration Files - =/ vt B
| jg Server Resources @ @Cverride [#7¥ Database Next
-7 Source Packages = public void prerender(} { [*7 Database Previot
. Test Packas stCurrentTime.setText ("Current time on the server is
B} fy TestPackages ) _ |57 set Value from Di
[ Libraries + new java.util.Datel()):
| g Testlibraries - ' | | <79 Update Database
(% Project Woodstock Themes H [79 Primary Key Mett
G- | gg Component Libraries &l S = |5 Database Appen
[#-Mgg Data Source References -
- [*7 Database Delete
: Navigator LI . = Application —
| Members View - | * { [+ Retrieve Value fr
P R
] m b - z()</code>, [+ Store Value in Se
e * acguirz ng execution of an event - )
= = 1 S |57 Retrieve Value fr
fe (DEE)E) = ’ i 3 - -

[ 1121 |ms

FIGURE 41.6  You can modify the code in the Java tab.

5. Right-click on the jsfdemo project to display a context menu and choose Run to run the
JSE This starts a Web browser to display the current date and time, as shown in Figure 41.1.

Note

By default, the first page in the project is set as the main page. You can access it using the URL

http://localhost:8080/jsfdemo. The explicit URL for this page is http://localhost:8080/jsfdemol/faces/ explicit URL
CurrentTime.jsp.

@jﬁ Note

" Ifyou choose the JSP tab, you will see the corresponding JSP file, as shown in Figure 41.7. The contents JSP file
of this file in XML mirrors the Ul components in the Design pane. Whenever you add, remove, or
change the Ul components in the Design pane, the contents in the JSP are also updated. It is possible
to modify the JSP file directly, but this is not recommended for new users. Modifying the JSP file mis-
takenly could corrupt the entire project. You can completely ignore the JSP file when using this tool.

@ Note

" Clicking the Java tab in the content pane, you will see the Java source file, known as the page bean page bean file
file. This file contains several methods. Among them are the four JSF life-cycle methods init, init
preprocess, prerender, and destroy. preprocess

The init method is called whenever the page is navigated to, either by directly via a URL, or prerender

indirectly via page navigation. The preprocess method is called after the component tree has
been restored, but before any event processing takes place. The prerender method is called

o
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[ ] jsfdemo - NetBeans IDE 6.7
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FIGURE 41.7 You can see the code in the JSP tab.

destroy

create a new page

just before rendering takes place. This method will be called only for the page that will actually be
rendered. The destroy method is called after rendering is completed for this request.

All these methods are automatically implemented. You can add the code to customize their
behaviors. Normally you should customize the prerender method to set appropriate properties
for the components for rendering.

41.3 JSF Ul Components

JSF provides many user interface components that you can use in visual design. These compo-
nents are comparable to Swing components. They are JavaBeans components with similar prop-
erties and events as their counterparts in Swing. The frequently used components are grouped
into the Basic and Layout nodes in the Palette window. This section introduces some standard
components such as text fields, drop down lists, list boxes, radio buttons, check boxes, text areas,
and buttons, through an example. The example is to design a form, as shown in Figure 41.8.
Clicking the Register button displays the input in a separate form, as shown in Figure 41.9.
The example can be completed in three phases:

1. Create the initial input form.

2. Create the result form.

3. Write the code for handling the event.
Phase I: Creating the input form

1. Right-click the jsfdemo node in the Project window to display a context menu, and
choose New > Visual Web JSF Page to display the New Visual Web JSF Page dialog
box. Enter Registrations in the File Name field. Click Finish to create Registra-
tions.jsp, as shown in Figure 41.10. Right-click Registration.jsp in the Projects pane to
display a context menu and choose Set As Start Page so this page will start when you
run the jsfdemo project.

o
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= http:/ /localhost: 8080/ jsfdemo/ faces fRegistrations.jsp - Windows Intel | |i|
@J\r)v I@ http://localhost:8080/jsfdemoy/faces/Registrations.jsp j *4 [ X IGcche P~
7 4% [E nttp://ocalhost:8080fjsfdemo/faces/Ragi... | | J v ~ ™ v pPagev (OiToosv

Student Registration Form

Last Name: | Smith MI: | T First Name: .John

Gender: & Male ( Female

Major: [Computer Science ] Minor:
Mathematics [ - |

Hobby: ¥ Tennis [ Golf [~ Ping Pong

Remarks:
No remarks =]
=l
o

FiIGURe 41.8 The form consists of various Ul components.

2] http:/ /localhost:8080/jsfdemo ffaces/Registrations.jsp - Windows Inte: - |0 ll
@'—)' I@ http:/flocalhost:8080/jsfdemo/faces/Registrations.jsp j *x (X IGcche P~
S <l [F http:/focahost:8080/jsfdemoffaces/Regi... | | ] ) ~ ™ v [ Page v (CiTook v

Last name is Smith

Miis T

First name is John

Selected gender is Male

Selected major is Computer Science
Selected minors are Mathematics
Selected hobbies are TennisGolf

Remarks are No remarks

FIGURE 41.9 The result from the input form is displayed in this form.
2. Drop a Static Text in the Design pane with the text Student Registration Form. You
can set a new font and color in the styTe property in the Properties window, if you wish.  set font and color

3. Drop a text field and set its id to tfLastName, column to 15, and Tabel to Last create a text field
Name:, as shown in Figure 41.11.

4. Drop a Text Field and change its id to tfM1i, column to 1, and Tabel to MI:. create a text field

5. Drop a Text Field and change its id to tfFirstName, column to 10, and Tabel to create a text field
First Name:.

6. Drop a Radio Button Group. Change its id property to rbgGender, columns property  radio button group
to 2, and T1abel to Gender:.

7. Right-click the radio button group object in the Design to display its context menu, radio button values
choose Configure Default Options to display the Options Customizer dialog box. Set
the appropriate display and value, as shown in Figure 41.12(a).

8. Drop a Drop Down List and change its id to ddMajor and Tabel to Major:. drop down list

o
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FIGURE 41.10 A new JSF page is created.
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FIGURE 41.11

® Options Customizer - rbgGend

tfLastName has been moved to desired location.

W Options Customizer - ddMajor

™ selectitems T~ Allow multiple [ Selectitems T~ A4
Display Value Mew Display Value New
Male Male Mathematics |Mathematics | R |
Computer Science Computer Science —

OK

| Cancel |

Aoply

[ o |

Cancel | Apply |

(a) For radio buttons

(b) For list box

FIGURE 41.12  You can customize the display name and value for radio buttons and list boxes.
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9. Right-click the list in the Design to display its context menu, and choose Configure list values
Default Options to display the Options Customizer dialog box. Set the appropriate
display and value, as shown in Figure 41.12(b).

10. Drop a List Box and change its id to ThxMinor, Tabel to Minor:, rows to 2, and list box
multiple to true.

11. Right-click the box in the Design to display its context menu, and choose Configure
Default Options to display the Options Customizer dialog box. Set display and value
the same as shown in Figure 41.12(b). list values

12. Drop a Check Box Group. Change its id to chkgHobby, Tabel to Hobby:, and check box group
columns to 3. Right-click the box in the Design to display its context menu, choose
Configure Default Options to display the Options Customizer dialog box. Set the dis-
play name and values for Tennis, Golf, and Ping Pong.

13. Drop a Static Text with the text Remarks:.
14. Drop a Text Area with id and columns set to taRemarks and 70. create a text area
15. Drop a Button and set its id to btRegister and its text to Register. create a button

16. Add binding attribute for tfLastName, tfMi, tfFirstName, rbgGender, ddMa-
jor, TbxMinor, chkgHobby, and taRemarks. To add binding attribute for a com-
ponent, right-click the component in the Design pane to display the context menu and
choose Add Binding Attribute. add binding attribute

The user interface for the input is now created as shown in Figure 41.13. All these components
are contained in forml. Now create form2 for displaying the data collected from the first form.

[ ] jsfdema - NetBeans IDE 6.7

File Edit View Mavigate Source Refactor Run Debug Profile Team Tools Window Help
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FIGURE 41.13 forml is created to contain input components.
Phase II: Creating the result form

1. Uncheck the visibTle property for forml to set it false so forml is not displayed in
the Design pane.

2. Drop a Form from the Layout tab in the Palette pane to create a form named form2, as  create another form
shown in Figure 41.14.

o
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FIGURE 41.14 forml is invisible. form?2 is created.

3. Drop eight Static Texts into form2 and set their id to stlLastName, stMi,
stFirstName, stGender, stMajor, stMinor, stHobby, and stRemark, respectively,
as shown in Figure 41.15. Add binding attributes for all these static texts.
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| form2 - Navigator [ x ‘ Static Text (#] Button
-0 fa :' Static Text : & Hyperlin
&-d] [ OStatic Text Lo 1
zmsmame R s EREEEESLIENY  [[emzpe. DX
stFirsthlame Seatic Texe i . Ii!eeneral F J -
.......... .. I ITTR
stGender Static Text .
stMajor : R P o form (7]
stvlinor T o ~g - |form2 (Form)
stHobby : : .
B-1A] sRemark LI o oo L.

FIGURE 41.15 Static texts are added to form2.

4. Set the rendered property in form2 to false. form2 will not be displayed when the

page is started.

5. Now check the visible property of forml to true and the visible property of

form2 false.

6. Add binding attributes for forml and form2. In the Navigator pane, right-click forml
to display the context menu and choose Add Binding Attribute. Similarly you can add

binding attribute for form2.

o
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Phase I11: Handling the event

We are ready to implement the code to handle the event for the Register button. Double-click
the Register button to generate the handler method btRegister_action in the page bean
file. Implement the methods as follows:

1 public String btRegister_action() {

2 // TODO: Replace with your code

3 forml.setRendered(false);

4 form2.setRendered(true);

5 form2.setVisible(true);

6 stLastName.setText('Last name is " + tflLastName.getText());

7 stMi.setText("MI is " + tfMi.getText());

8 stFirstName.setText("First name is " + tfFirstName.getText());
9

10 stGender.setText("Selected gender is " +

11 rbgGender.getSelected().toString());
12 stMajor.setText("Selected major 1is " +
13 ddMajor.getSelected() .toString());
14

15 String[] selectedMinors = (String[]) (TbxMinor.getSelected());
16 String minors = "";
17 for (int i = 0; i < selectedMinors.length; i++)

18 minors += selectedMinors[i];
19 stMinor.setText("'Selected minors are " + minors);
20

21  String[] selectedHobbies = (String[]) (chkgHobby.getSelected());
22 String hobbies = "";

23 for (int i = 0; i1 < selectedHobbies.length; i++)

24 hobbies += selectedHobbies[i];

25 stHobby.setText("Selected hobbies are " + hobbies);

27 stRemark.setText("Remarks are " + taRemarks.getText());
28 return null;
29 }

Clicking the Register button displays form2. forml’s rendered property is set to false
(line 3) in order to hide it. form2’s rendered property is set true to make it visible (line 4).
form2’s visible property is set true to ensure that the form itself is visible (line 5). For a
component to be displayed, both visible and rendered properties must be true.

All the JSF UI components are JavaBeans components. Their properties have the associated
get and set methods. You can obtain the text in a text field and text area using the getText ()
method (lines 6-8). You can obtain the selected items from the a radio button group, check box
group, drop down list, or list box using the getSelected() method (lines 11, 13, 15, 21).

@ Note

" The second form is displayed when the Register button is clicked. When form2 is displayed,
forml will not be shown. This is achieved by setting form1’s rendered property to false.
Note in the Design pane, you are free to move form2 to a desired location even if it overlaps forml.

41.4 JSF Ul Containers

Like Swing, JSF provides containers that can be used to group components to achieve a de-
sired layout. Three containers are available under the Layout node in the Palette: GridPanel,
GroupPanel, and LayoutPanel. GridPanel is like the Swing GridLayout. GroupPanel
is similar to the Swing FlowLayout. LayoutPanel organizes child components using flow
or absolute positioning.

Consider the following example that computes loan payments. The example lets the user
enter a loan amount, number of years, and annual interest rate, as shown in Figure 41.16.

o

event handler

forml not rendered
form2 rendered

get text

selected radio button
selected item

selected items

getText()

getSelected()

GridPanel
GroupPanel
LayoutPanel
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Clicking the Compute Loan button displays the monthly payment and total payment, as
shown in Figure 41.17.

=

Fle Edit View History Bookmarks Tools Help
| LI http://localhost:8080/jsfdemo/faces/ComputeLoan.jsp | Y| L= l

-
Loan Amount: 10000
Humber of Years: 5

Annual Interest Rate 55-|

| Done

NN

FIGURE 41.16 The form lets the user enter loan information.

1ol

File Edit View History Bookmarks Tools Help

| [ http://localhost: 8080/jsfdemo/faces/ComputeLoan.jsp | Y| D’]
Loan Ameount: 10000
Number of ¥Years: 5
Annual Interest Rate: 55

.. Computeloan i
Monthly Payment 191.01162171781937
Total Payment 11480 657303089162
\ Done v

FIGURE 41.17 The loan payment is computed and displayed.

Here are the steps to create the Ul:

1.

Right-click the jsfdemo node in the Project window to display a context menu, choose
New > Visual Web JSF Page to display the New Page dialog box. Enter Computeloan
in the File Name field. Click Finish to create ComputeLoan.jsp. Set ComputeLoan.jsp
as the start page for the project.

2. Drop a GridPanel to the Design pane and set its id to gridPanell and columns to 2.

. Drop a Static Text, a Text Field, a Static Text, a Text Field, a Static Text, and a Text

Field to the grid panel in this order. Set the static text to Loan Amount, Number of
Years, and Annual Interest Rate. Change the text fields id to tfLoanAmount,
tfNumberOfYears, and tfAnnualInterestRate. Add binding attributes for the
text fields.

. Drop a Button to the grid panel and set its id to btComputelLoan and text to

Compute Loan.

. Drop another GridPanel to the Design pane below the preceding grid panel and set its

id to gridPanel2 and columns to 2.

. Drop a Static Text, a Text Field, a Static Text, and a Text Field to gridPanel 2 in this

order. Set the static text to Monthly Payment and Total Payment. Change the id of
the text fields to tfMonthlyPayment and tfTotalPayment. Add binding attributes
for tfMonthlyPayment, tfTotalPayment, and gridPanel2.

The user interface is created as shown in Figure 41.18.

o
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[ ] jsfdemo - NetBeans IDE 6.7

File Edit View Mavigate Source Refactor Run Debug Profile Team Tools Window Help

FHESE DE: =R ATMON

|Qv| Search (Ctrl+l)

iPro.. 4 ®|:Files

5:] ComputelLoan * ﬁl@ Loan.java $|

| i Services

@ E] @ i Palette

B@ jsfdemo

L'—Jlb Web Pages

[0y wWEB-INF
"'U—» resources
.EID Computeloan, jsp
Ej CurrentTime.jsp
5:] Registrations.jsp

Design | 15¢  Java |Ggl & (| Any Size

| Loar &mourt:

=l Woodstock Basic
f Label

|A] Static Text
] Text Field
|l—_f| Text Area

ot | B 1

t-| & Configuration Files

: etaticTexth:Total Payment: ...

| fig Server Resources

: staticTexthTotal Payment: - Navig... <0 2 Camgute Loan W

style

= General

= Appearance

styleClass

staticTexts

Mor&hly Fiayrnérrt: :

-
Filters: @

staticTexth:Total Payment:
staticText5 (StaticText)

Tip
If the order of the components in a panel is not correct, you can reorder them in the Navigator
pane using the mouse.

Double-click the Compute Loan button in the Design pane to generate the method
btComputeloan_action(). Implement it as follows:

1 public String btComputelLoan_action() {

double ToanAmount =
Double.parseDouble(tfLoanAmount.getText().toString().trim())

int numberOfYears =
Integer.parselnt(tfNumberOfYears.getText().toString().trim();

double annualInterestRate = Double.parseDouble(
tfAnnualInterestRate.getText().toString().trimQ);

chapter4l.Loan loan = new chapter4l.Loan(
annualInterestRate, numberOfYears, loanAmount);

ey
ROoOwoNOUVIh WN

12 gridPanel2.setRendered(true);
13 tfMonthTyPayment.setText(Toan.getMonthlyPayment() + "");
14 tfTotalPayment.setText(loan.getTotalPayment() + "');

16 return null;
17 3

The handler obtains ToanAmount, numberOfYears, and annualInterestRate from the
input text fields (lines 2—7). The program creates a Loan object (lines 9-10). You need to cre-
ate a Loan class for this method to work. To create the Loan class, choose File >» New > Java
Class to display the New Java Class dialog box. Enter Loan in the Class Name field and
chapter4l in the package field. The Loan class was given in Listing 10.2.

Set gridPanel2’s rendered property to false. Run the program using the URL
http://localhost:8080/jsfdemo/faces/ComputeLoan.jsp. You will see the user interface, as shown in

o

[ 206:1 |ms

reorder components

get ToanAmount
get numberOfYears

get annualInterestRate

create a loan

gridPanel2 rendered true
display monthly payment
display total payment

create Loan class
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Figure 41.16. When you click the Compute Loan button, gridPanel2’s rendered property to
true (line 12). You will see the monthly payment and total payment displayed in Figure 41.17.

41.5 Binding Data with Ul Components

You can bind data from a SQL query to a JSF UI component. This is a powerful feature and
makes database programming easy. These JSF UI components are known as data-aware
components.

Consider the following example that lets the user choose a course, as shown in Figure 41.19.
After a course is selected in the drop down list, the students enrolled in the course are displayed
in the table, as shown in Figure 41.20. In this example, all the course titles in the Course table
are bound to the drop down list and the query result for the students enrolled in the course is
bound to the table.

/2 http:/ flocalhost: 8080/ jsfdemo/faces/ DisplayStudent.jsp - Windows 1i _|o|x|
@‘\‘)' I@ http://localhost:8080/jsfdemoyfaces/DisplayStudent.jsp j 5| K IG:che P~
¢ 94 [ nttp:/flocainost:8080/jsidemoffaces/Displ... | | ] 3~ B v o v Sy page v (O Took v
=]
Choose a course: [Infro o Java | =]
Intro to Java |
010
Database Systems
Rapid Java Application Birth
ssn +, | firstyCalculus | phone 1 |Date 1+ deptld +
Calculus Il
444111111 Jonn |52 9129219434 BIOL
444111116 Josh (Database Administration ot20210434 FEL9 mioL
244111117 Joy P Kemnedy  Ot20220434 19 g
444111112 Toni R Peferson 0120920434 PLZ% waTh
El

FIGURE 41.19 You need to choose a course and display the students enrolled in the course.

/2 http:/ /localhost: 8080/ jsfdemo/faces/DisplayStudent.jsp;jse: - O] x|
mv |@ http://localhost: B080/jsfdemo/faces/Dis j *y (| 2 |Gssgle PeliRs
= »
W HR @http:ubcamoat:amsm,rjsfdemo,rf...| H I v B - ™m0 v oy page v (0 Tooks v
2]
Choose a course: | Intro fo Java l =]
Birth
ssh + | firstName +, mi + | lastName +, |phone =+ |Date « |deptld +
444111111 John K Stevenson 9120219434 BIOL
444111118 Toni R Peterson 0120220434 /PLZ% maTH

FIGURE 41.20 The table displays the students enrolled in the course.

To develop this example, first you have to create a new database connection. In the
Services pane, right-click the Database node and choose New Connection in the context
menu (Figure 41.21(a) to display the New Database Connection dialog box, as shown in
Figure 41.21(b)).

Use the same MySQL database we have been using since Chapter 37. Enter the database in-
formation, as shown in Figure 41.21(b). Click OK to create the database connection. You will
see the database under the Databases node in the Services tab, as shown in Figure 41.22.

o
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| Projects

J I

| | Files | | Services 4l = |

g
-1 Drivers
Eﬂ jdbc ik

hle [app on APFP]

7-53 jdbc:d | [travel on TRAVEL]
Ej jdbe Disable Debug ir on VIR]

Eﬂ jdbc:mysql: /flocalhost/javabook: [scott on Default schema]
Eﬂ jdbc:mysql: /flocalhost/testrautoReconnect=true&zeroDate’
W web Services

@ Enterprise Beans (2.x)

Servers

Enable Debug

||

FIGURE 41.21

File Edit VWiew Navigate Source Refactor Run Debug Erof Team Tools Window Help

(a)

41.5 Binding Data with Ul Components 41-15

L] New Database Connection — )

Basic setting

Data Input Mode: (@ Field Entry (7) Direct URL Entry

Name: :MySQL (Connector/J driver)
Host: localhost

Part:

Databagze: javabook

User Name: scott

Password: ssens

Remember password
({see help for information on security
risks)

Additional Frops:

S"IUW,J“DBC RL jdbc:mysgl: {flocalhostjavabook

(b)

You can create a database connection from the Services pane.

L] NetBeans IDE 6.7

HEES

I:E E@ |> ' @ - |Qv|SEalch (Ctrl+T) |

i Projects ‘ Files ‘ Services 4 s || [&] 50L Command 1 $| EE
-8 Datmbases BIEET-Yo -l M AL T
[i MySQL Server at localhost: 3306 [agsuser] {disconnects IE;elect, e T e —
+ [2 Java DB -
G| J) Drivers
Eﬂ jdbc:derby: flocalhost: 1527 /sample [app on AFF]
Eﬂ jdbe:derby: flocalhost: 1527 travel [travel on TRAVEL]
[ j jdbc:derby: flocalhost: 1527 fvir [vir on VIR]
-- jdbc:mysql: fflecalhost/cpplivelab2e?autoReconnect=tr|
= jdbc:mysql: fflecalhostfjavabook [scott on Default sche
& information_schema
=& javabook
E—J_| Tables
[E: I:l account
[E I:l address = ||| select * from javabook.co 2 |
- college
E % cwge BEEEET @K < > M raese o | Toti
G- cscitant #* courseld  subjectid  courseMumber  title
e csaitan 1 1111 csal 1301 Intro to Java -
e escimm0 H 1112 csal 1302 Inro to Java It
&[] department 3 11113 €Sl 4720 Database Systems
-ff] enroliment 4 11114 cscI 4750 Rapid Java Application
-] facutty 5 11115 MATH 2750 Caleulus T
&-f] person 6 11116 MATH 3750 Calculus T
- auiz 7 11117 EDUC 1111 Reading
-] staff 8 1118 IEC 1344 Database Administration
-] statecapital -
[ I:l student i < m ] )
[ I:l subject
@[] taughtby i Qutput B
] Views u> = S SQL Command 1 execution = =
-1 Procedures a jsfdema {run) ® Java DB Database Process = =
H- B2 mysql || | zun: "
‘ l— = m | s %a BUILD SUCCESSFUL (total time: 0 seconds) -
E 11 |ms

FIGURE 41.22 You can access the database from NetBeans.

Create a new Visual Web JSF page named DisplayStudent and create the user interface

create new page

by dropping a Drop Down List, and a Table to the Design pane, as shown in Figure 41.23.
Name the drop down list and table as ddCourse and thStudent. Set the Tabel property for
ddCourse to Choose a course:.

create Ul

o
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® jsfdemo - NetBeans IDE 6.0.1
File Edit View Navigate Source Refactor Build Run Profle Versioning Tools Window Help

=10 x|

H

FOES X 20D TE DB O

|Pro.. 40 x ‘ | Files |JService= | DisplayStudent * XI ﬂﬂ ;I EI | Palette 0 x
i g-%ﬁ\f\fzg Fages . i = = | g IAHY Size LI &1 Checkbox Group =
1 S S S S A () Radio Button —
]| Computel oan. jsp - - Choose a Course: Iltem1 jv ..................... \.)) Radio Button Grouy
&) CurrentTime.jsp N %] Image
18] DisplayStudent. jsp hd [ Table LI
4 | I 4 | eolumni ﬂ | column2 | column3 4 =
JihStudert - Proper... v X
| et - MEUEEED W E8 | rol _columnt rowyl_columnz rowe ] _column EGeneral "
: ;I o2 _columnd row2_column2 rowe2_column3 id thst... J
o3 _columnd o3 _column2 roswd_columnia ElAppearance LI
J roved_column row4_columnz rowed_columns =. !
| rowes_column rowsS_column2 rows_columna thStudent 0
oo ' " T table1 (Table)
E ddCourse e
4+ =

FIGURE 41.23 The user interface is created in the Design pane.

File Edit View MNavigate Source Refactor Run Debug Profile Team Tools ﬂindowep

] jsfdemo - NetBeans IDE 6.7 "

PSS DC T DG

‘ Q.+ | 5earch (Cirl+1) |

i Projects ‘ Files | = @ 5QL Command 1 8 ||@ DisplayStudent * sg‘ EDEE] i Palette o=
E1-& Databases *|[Desin ] s e |G & P Anysize = -
. [i My5QL Server at localho T — — - T " [FH Cheddox Group
= B Java DB A L N S — | | (&) Radio Button (B
Ay Drivers E ChooseaCourse: ™M1 . <[ @) Radio Button Grous
Ef—l jdbeiderby: flocalhost: 1 IE‘ Image
E;l jdbe:derby: fflocalhost: 1
‘B3] jdbe:derby: flocalhost: 1| | [ Table
IEI jdbecimysgl: flocalhost/cp [E] Table Column
=+ abemysal: flocalhostfia courseld | % subjectld | % courseHumber | % title | % | ||| Table Row Group
@& information_schema e T il
& javabook abo abc 123 ahc 123 ‘assword Fiel
H— i courseDataPr.. > =
i EbL] Tables she abe 123 abe 123
[ account - =/Beneral
[F] address s abe 123 abe 123 |||id cour... [
[Helege || — 7 s
[ course - cachedRowSe[:]
CCE = Sl S Events
dataListener D
i courseDataProvider - Navi... <@ %
mrmreem— transactonea L]
E-F] formi refreshableDate B}
BB ddcourse |} tableDataL isten =
@ whstudent [TILF - - - tableCursorList E]
i & ddCourseDefaultOptions |5
B i | [courseDataProvid... 0
-] RequestBean1 - + | |hedRowSetDataProvider 1
i T G < I s chedRowSetDataProvider)
B 1 [ms

FIGURE 41.24

create data provider
bind data

A data provider is created.

The drop down list should be bound to the course titles from the Course table. Click the
Course table in the database connection under the Database node in the Services pane, as
shown in Figure 41.22. Drop the Course table to the table component in the Design pane. You
will see courseDataProvider created in the Navigator pane, as shown in Figure 41.24.

To bind the data for ddCourse, right-click on ddCourse to display a context menu in the De-
sign and choose Bind to Data to display the Bind to Data dialog box, as shown in Figure 41.25.
Select course. courseld in the Value field and course. title in the Display field. Click OK
to close the dialog box. Add binding attribute for ddCourse.

o
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The table should be bound to a query result for the students enrolled in a selected course.
Click the Student table in the database connection under the Database node in the Services
pane. Drop the table to the table component thStudent in the Design pane. You will see
studentDataProvider created in the Navigator pane, as shown in Figure 41.26.

Each data provider has a cachedRowSet property that specifies a RowSet. studentDat-
aProvider uses studentRowSet, as shown in Figure 41.27. Double-click studen-
tRowSet under the SessionBeanl node in the Navigator pane to display the row set in the

content pane, as shown in Figure 41.28.

[ ] Bind to Data - ddCourse

Current Items property seting

#{DisplayStudent. courseDataProvider. options['course. courseld, course. tide}

Bind to Data Provider | Bind to an Object

create data provider

i

Value field:

Choose a Data Provider to bind to ddCourse:
|courseDataProvider (DispbyStudend

Display field:

course.courselumber nfeger
course.title Sting
course.numOfCredits Infeger

<use value field>

course.courseld Stning
course.subjectld Sting
course.courseumber Inieger

course.numOfCredits Tnieger

[

Ok

| (oo ) oo ] [

FIGURE 41.25 You can set value and display name in a drop down box.

of

File Edit View Mavigate Source Refactor Run Qeug Profile Team Tools Window Help

)

B HC

T D BR-G-

|Q'| Search (Cirl+1) |
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- [T |-
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- @ SessionBean 1

; Projects | Files EIEE] [; patette »®
; o
4|[Desin] 1p  mva | & @& [ AnySiz= - 7] chedkbor Group
= v
M T T N =)
- s s — | | (=) Radio Button
= iChoose a Course: |2 ) 8)) Radio Button Group
statecapital |a s S : @
= (24| Image
E student
A subject e Table
D om T tauekthe T [ Table Column i
4 lalll E ssn t mi lasthame | %+ phone  *| |[: studentDataP.. D> %
: studentDataProvider - Ha... 1 % abe e e e = || [EGeneral -
&[] body1 . id st )
Er-(] form1 | ke ahe ahc ahc = Data L
ddCours: cachedRows(i. v )|
@ thStuder | - | abc ahc ahc ahc IElEvents L
-5} courseDataProvider dataListener [

transactionall D -

studentDataProvi... 9

[ ApplicationBean1 - - | |hedRowsetDataProvider 1
< ] » 4 chedRowSetDataProvider)
B 1 |ms
FIGURE 41.26 The studentDataProvider is created.
Modify the query as follows:

select all Student.ssn,
Student. firstName,
Student.mi,

modify query

display query visually
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[ ] NetBeans IDE 6.7

File Edit View Mavigate Source Refactor Run Debug Profile Team Tools Window Help
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: studentRowSet:"SELECT ALL stud... 0 2 = id st... E] 1
i SE... S
B8] DisplayStudent abc ahbc abe abe . command [
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-[@ studentDataProvider  |f . fetchSize o
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FIGURE 41.27 You can define a SQL statement in studentRowSet.

[ ] NetBeans IDE 6.7

File Edit View Mavigate Source Refactor Run Debug Profile Team Tools Window Help
: = : I8  JH n 5 - - | Search (Cirl+D)
3 B DE: T D ) [Qlseaer G |
: Projects | Files | Se... = @ S0L Command 1 ss|5] DisplayStudent * 8 |gj jdbe:mysgl: {locahostfjavabook [scott an Default schema] ss| @E @
: facul B -
D culty < student [Table]
B ssn - |
FirstMame |E‘ =
[ statecapital s mi A
[ student |E| lastMame 1 il
| L
I:l subject
Column Alias Table Output Sort Type Sort Order Crit
01 Views ssn |student | | | -
<[ m | v firsthame | |student | | | | Al
4 | m | 3
i Navigator A% | Ay
select all S =
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&

FIGURE 41.28 The query is visually displayed in the content pane.

Student.lastName,
Student.phone,
Student.birthDate,
Student.street,
Student.zipCode,
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Student.deptId
from Student, Enrollment, Course
where course.courseld = ?
and student.ssn = enrollment.ssn
and enrollment.courseld = course.courseld

Note that the ? mark is a placeholder for the prepared statement. Close and reopen

prepared statement

studentRowSet. You will see the new data diagram, as shown in Figure 41.29. If you don’t

see it, go back to the Design pane and refresh the project, then reopen studentRowSet.

(] NetBeans IDE 6.7 (=
File Edit VWiew Mavigate Source Refactor Run Debug Profile Team Tools Window Help
FEES 9E T8 DB G Q= |
: Projects | Files | Se.. R @ SQL Command 1 22 ”5] DisplayStudent = si|5j jdbc:mysgl: flecalhostfjavabook [scott on Default schema] Bi| EE @
: &[] faculty
[ person o student [Table]
E iz &= ssn -~ < enrollment [Table]
E staff firstName El [ &= sn o course [Tahble]
E statecapital E mi [[] &= courseld [[] == courseld -
El Sl 3 lasthame o |} dateRegistered [} E@ subjectld t
El subject = |l grade [} courseNumber H

: -] taughtby [ title

i1 Views = A

4 mm 3 p—

: - Navigator 4 2 | | Column Alias Table Output Sort Type Sort Order Crit
ssn lstudent [¥] -
firsthame istudent [¥] =
mi student ¥l -
4 m ] 3

Mo View Available™ ent.=sn, student, firstName®, =studenc.mi, student. lasclame, student.phone, stude
4 m »
AT
[ 1324 |ms
FIGURE 41.29 The tables and their relationship in the SQL query are visually displayed.
You can customize the table’s layout by right-clicking the table in the Design pane and
choosing Table Layout to display the Table Layout dialog box, as shown in Figure 41.30.
Choose the selected columns and set the header for birthDate to Birth Date, as shown in
Figure 41.30. Click OK to close the dialog box. bind data
Drop a Message Group component to the upper right corner of the page. This component  Message Group

is useful to display diagnostic errors.
Double-click the drop down list to generate the ddCourse_processValueChange-
(ValueChangeEvent event) handler and implement it as follows:

1 public void ddCourse_processValueChange(ValueChangeEvent e) {
2 try {

3 getSessionBeanl() .getStudentRowSet () .setObject(

4 1, ddCourse.getSelected());

5 studentDataProvider.refresh();

6 1}

7 catch (Exception ex) {

8 error(ex.toString());

9 1}
10 }

The studentRowSet object can be obtained using setSessionBeanl().getStuden-
tRowSet() (line 3). studentRowSet object is an instance of JDBC RowSet. The

o

set courseld
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[ ] Table Layout - th5tudent

Get Data From: :shﬂenﬂ)atapmvider (DisplayStudent

Available Selected

student.ssn
student.street student. firsthame
student.mi
student.lastName
student.phone
student. deptld
student.birthDate

Column Details

Header Text: Birth Date|

Footer Text:

Component Type: :SmﬁcText

Value Expression: | #{currentRow. value['student.birthDateT}
Width:

Horizontal Align: v: Vertical Align: :<not set= v:

Sortable

[ oK H Cancel H Apply H Help

FIGURE 41.30 You can customize the layout of the table.

setObject method sets the parameter value (line 4). The refresh() method executes the
query for the row set.
The error method displays the error message in the Message Group component (line 8).
The Message Group component is not displayed if the error method is not called.
override prerender Replace the body of the prerender method with the following code to ensure that the
table is properly displayed initially.

public void prerender() {
try {
if (ddCourse.getSelected() == null) {
courseDataProvider.cursorFirst();
getSessionBeanl() .getStudentRowSet().setObject(
1, courseDataProvider.getValue("Course.courseld"));
studentDataProvider.refresh();
}
}
catch (Exception ex) {
error(ex.toString();
}
b

auto-submit Right-click on the drop down list in the Design pane to choose Auto-Submit on Change. In the
Properties window, the following code appears in the onchange property:
webui .suntheme.common. timeoutSubmitForm(this.form, 'ddCourse');

Now when the user changes a value in the drop down list, the Web browser automatically sub-
mits the change.

Run the program using the URL http://localhost:8080/jsfdemo/faces/DisplayStudent.jsp. You
will see the user interface, as shown in Figure 41.19.

o
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41.6 Session Tracking

Chapter 40, “JSP,” introduced session tracking using JavaBeans by sharing the JavaBeans ob-
jects among different pages. You can specify the JavaBeans objects at the application scope,
session scope, page scope, or request scope. JSF supports session tracking using JavaBeans at
the application scope, session scope, and request scope.

Consider the following example that prompts the user to guess a number. When the page starts,
the program randomly generates a number between 0 and 99. This number is stored in the session.
When the user enters a guess, the program checks the guess with the random number in the session
and tells the user whether the guess is too high, too low, or just right, as shown in Figure 41.31.

_lojx]

File Edit View History Bookmarks Tools Help

& - - @ X m‘ |L| http:,-’fbcalhoat:8Cl8ijsfdemoffacestuestumber.jsp|v L“»]

Enter your guess: |50 I

Too high LI

| Done p
9 Morzilla Firefox (=] 53

File Edit View History Bookmarks Tools Help

& - - @ X m | (I http://localhost:8080/jsfdemo/faces/GuessNumber.jsp | v | [ |

Enter your guess: 25

Too low ZI
| Done v
_iolx|

File Edit View History Bookmarks Tools Help

& - - @ &9 m‘ |L| http:f,-’bcalhoat:8D8D,-’jsfdemo,-’faces,-’Guestumber.jsp|v| L‘»]

Fy

Enter your guess: |40

“ou got it!
| Done

NEN

FIGURE 41.31 The user enters a guess and the program displays the result.

Create a new page named GuessNumber and create the user interface by dropping a text  create GuessNumber page
field with id tfGuess and Tabel “Enter your guess: ” and a Button with id btGuess, and
a Static Text with id stResponse for displaying the program’s response to the user’s guess,

as shown in Figure 41.32. Add binding attributes for tfGuess and stResponse. create Ul
To store the random number in the session, create a property named number in

SessionBeanl. java with get and set methods as follows: session bean property
int number;

public int getNumber() {
return number;
3
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public void setNumber(int number) {
this.number = number;

3

SessionBeanl .java is in the Source Packages folder in the jsfdemo project.
Add the following highlighted code in the constructor of SessionBeanl .java, as shown in

Figure 41.33:

public SessionBeanl() {
create random number number = (int) (Math.random() * 100);

3

(J jsidemo - NetBean=TDEG.Z E=EER)

File Edit View Mavigate Source Refactor Run Debug Profile Team Tools Window Help

E—] % | <default config - | I:E E&y |> - @ - |Qv|Sea|'ch (Ctrl+1)
iP. A= | Files | Services @ Guesshumber $| @E @ i Palette I

f—]@ jsfdemo » | [ Design 15p Java | f= Ml :,Qny Size = Woaodstock Basic
EHlfp WebPages o " (% Label ‘

sapiadolyg E

G-[)) WEBINF L T || (A] static Text
.. Enter Your Guess: || | L o | E Text Field

-§] computeLoan.jsp
5] CurrentTime.jsp

5] DisplayStudent.jsp

5] GuessNumber.jsp LoD Lo @ Hyperink

= S =| Text Area
OStatic Text 1 —
..o |+ | Button

| ol | Il : 3 image Fyperink
S S =] Drop Down List

|| 2] Listbox

] Checkbox

|| &1 Checkbox Group

e kie

53]

FIGURE 41.32 The user interface is created in the Design pane.

[ ] NetBeans IDE 6.7

File Edit View Navigate Source Refactor Run Debug Profile Team Tools Window Help

HEES DE TBH DB O Q=som |

SPr. = | Files ‘ Services 5] GuessMumber * 2 | |ﬁ—_5| SessionBean 1.java * $| EE E]
W= = =} E ] = =
5@ isfdemo EBR-E- RSB FeR e D=
9"'«:0 Web Pages package jsfdemo: =
I WEB-INF = F
Il resources ) import com.sun.rave.web.ul.appbase.AbstractSessionBean; ‘E
5] Computeloan.jsp import com.sun.sqgl.rowset.CachedRowSetXImpl; —
@ CurrentTime.jsp import javax.faces.FacesException;
5] DisplayStudent. jsp
: EJDGUE_SSNUT‘,EL_]SD public class SessionBeanl extends AbstractSezssionBean {
""" 5] Registrations.jsp i |I{a:aged Component Def'_:it,io:|
: Navigator a =
Members View - o
Bﬁb SessionBeanl it AbstractSessiont & * <p>Construct a new =session data bean instance.</p>
- ¢ SessionBean1{) ‘ﬂ o
%) init() public SessionBeanl () {
- @ activate() =] number = {int) (Math.randem{) * 100);
-~ (@ destroy() ¥
% aetApplicationBean 1) ¢ Apcli ™
« [ [ r int number:
il -
fie (DB += O i )
B 471 |ms

jsfdemo deployed.

FIGURE 41.33  You can modify the code in SessionBeanl .java.

o
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Double-click the Guess button in the Design to generate the handler btGuess_action() implement button handler
and implement the method as follows:

1 public String btGuess_action() {

2 int guess = Integer.parselnt(tfGuess.getText().toString(Q.trim()); get guess
3

4 if (guess < getSessionBeanl().getNumber())

5 stResponse.setText("Too Tow"); too low
6 else if (guess > getSessionBeanl().getNumber())

7 stResponse.setText("Too high'); too high
8 else

9 stResponse.setText("You got it!");
10
11 return null;
12 }

A session bean object is automatically created when a session starts. The getSession- getSessionBeanl()
Bean1 () method (lines 4, 6) returns the session bean object.

41.7 Validating Input

In the preceding GuessNumber page, an error would occur if you did not enter a guess or
you entered a string rather than an integer before clicking the Guess button. A simple way
to fix the problem is to check the text field before processing any event. JSF provides sev-
eral convenient and powerful ways for input validation. You can perform validation to
ensure that the required field has been filled and the input is an integer for the preceding
example.

Consider the following example that displays a form for collecting user input as shown in
Figure 41.34. All text fields in the form must be filled. If not, error messages are displayed.
The SSN must be formatted corrected. If not, an error is displayed. If all input is correct,
clicking Submit displays the result in a static text, as shown in Figure 41.35.

£ Mozilla Firefox — 0| x|
File Edt \iew History Bookmarks Tools Help
St b e L (g |4 httpefflocalhost: 8080/jsfdemoy/faces/ValidateForm.jsp | =
Y
form1:tfiame: Validation Error: Value iz required.
Mame;
Enter a valid SSH, e.g., 123-44-55728
SEN: 1-2323-2323
form1:tfAge: Validation Error; Value is required.
Age: form1:tfHeight: Validation Error: Value is required.
Height:
-- =
| Done -

FIGURE 41.34 The error messages are displayed if input is invalid.

Create a new page named ValidateForm and create the user interface as follows: create ValidateForm page
create UL

1. Drop a GridPanel to the Design and set its columns to 2. Add four Static Texts, four . ...c a GridPanel

Text Fields, and a Button to the grid panel, as shown in Figure 41.36. Set the id

o
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property of the text fields to tfName, tfSSN, tfAge, and tfHeight, respectively. Set
the button’s id to btSubmit and Tabel to Submit.

2. Drop a Static Text below the grid panel and set its id to stResult. Set its escape
property to false so you can display HTML contents in the static text.

escape property

add binding attribute 3. Add binding attributes for t fName, tfSSN, tfAge, tfHeight, and stResult.

) Mozilla Firefox

File Edit View History Bookmarks Tools Help

=0l x|

& - - IEJ ‘ﬂ_l‘ |L| http:;‘;‘bcalhost:SDSD;'jsfdemoffacesNaﬁdateForm.jsp|v| [,-.]

Name; John Smith
SSN: 333-34-5678
Age: 41

Height: |57

The inputs you entered are
Name: John Smith

SSM: 333-34-0878

Age: 41

Height: 5.7

| Done

FIGURE 41.35 The Submit button is processed after input is validated.

File Edit View Navigate Source Refactor Run Debug Profile Team Tools Window Help
: | | DR = - - ~| Search ')
PSS D TR DB [Qlsen e |
iPr.. @ ®|:Files | services | ..ava 5] validateForm = s ELIE B [: patette ]
=[5 WebPages + || Design I 5P Java | & :My Size =l Woodstock Basic e
1)) wesne N R —— e 5 Label 'm
< )5 resources = ................ |A] Static Text
13| Computeloan.js :
Ej P _J P comamer ] [ Text Field
5:] CurrentTime, jsp 0
| SSHE =
5:] DisplayStudentjsp ~ |f - - R T R R |=] Text Area
-EJDGuessNumber.jsp Codae L (] Button
8] Registrations.jsp ' Height: =
5:] ValidateForm.jsp - : : : : : stResult - Properties - 52
E T Nav'gator @ - . m— . ......................... Style hE\ght: 96... E] o~
BT Hilame .. L—l ............................ styleClass &
0|8 swtcTextzs | g 0 b B text E]H
E-E thssN Static Text [SData
Iﬂ staticText3: L I converter :]
D (1] o SN escpe W
|A] saticTextt =0 (= Benavior =
G-E] tiHeight == -
(#] btSubmit:Submit o o B escape
. EESCape (DO0IEEN) ESCApe Te Nl
Iﬁ—l stResult E 1 text so it won't be interpreted by
] m 3 the browser as HTML
EE 170019 s

FIGURE 41.36 The user interface is created in the Design pane.

You can use the Message component to display input errors. Drop four Message components next
to each text field, as shown in Figure 41.37. To associate a Message component with a text field,
choose an appropriate value in the Message’s for property, as shown in Figure 41.37. Message will
automatically display an error message when input validation fails in the associated text field.

display error in Message
for property

o
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- — — ==
[ ] jsfdemo - NetBeans IDE 6.7 =)
Eile Edit View Navigate Source Refactor Run Debug Profile Team Tools Window Help
FHEHES DE T D E-® [Q-1search (ct+D)
:Proj.. 0% | Files | Services wuuber |E5| SessionBeanljava & |@ ValidateForm * $| E‘BE @ : Palette o> %=
TrTET T p = — = - : T e
: Design | ISP Java & B |Any size - -
L resources | - - @ Calendar
Computeloan. is [ N
% i P = B P AU~ O S - . || (& File Upload =
CurrentTime. jsp Name: oieszage summary for tikame o e
5] DisplayStudentjsp |} .. e . . T = Tree
5], Guesshumber.jsp B Message summary oSS |1 Tree Node
5] Reqgistrations.jsp -Ageg Meszzane summary for tiige | ] s
5] ValidateForm.jsp 1 T et T N [ vkt ||} messaged - Properties 03
Bt Ieszage summary for tiHeight O oI TTET v
; : " L A D S e A I S L =,
: message1 - Navigator am . : : : style height: 24px;... [:]
E||£| form1 P I styleClass E]
gridFanel D [=| Behavior |E|
[¢] btGuess:Button o T
A stResult [ e T T T bl :] i
e trage
< ! S e ) 17}
Q message2 L1l input wompanent fFHeight har
(D message3 the component assd il
[1-£3) messaged ar___ - - - - - - - - - - - - - - -~ - MESSA0E COMPONENtfs oy
2141 |ms

FIGURE 41.37 Four Message components are created in the Design.

For each text field, set its required property true to indicate that an input value is
required for the field.

You can validate the length of the input using the LengthValidator. Suppose the name
must have minimum 1 character and maximum 10 characters. To set its length validator,
choose new LengthValidator() in the validatorExpression property for tfName.
You will see TengthValidatorl appearing in the Navigator pane, as shown in Figure 41.38.
Set the minimum and maximum properties for TengthValidatorl to 1 and 10.

required property

LengthValidator

jsfdemo - NetBeans IDE 6.7
File Edit View Mavigate Source Refactor Run Debug Profile Team Tools Window Help
PSS DE TE D EB-®
:Proj.. = | Files | Services ...ber |E5| SessionBeanl.java §|E] ValidateForm * $| E‘]E @
tg] DisplayStudent jsp Desgn | 1% Java |G & 0 [Any Sie =)

| Qx| Search (Ctrl+I)

! Palette

& Anchor
@ Message
| Message Group

EJD GuessMumber.jsp
E] Registrations.jsp

5] ValidateForm.jsp Message summary for tfage

-l g Configuration Files
Bl fg Server Resources
Bl fg Source Packages

-

i1 Taet Dl

: lengthValidator1 - Navigator
iV message]
\,_i) message
message3
\D messaged
<o lengthValidator 1
|?_5] RequestBean1
|?_b‘] SessionBeanl
|?_b‘] ApplicationBean 1

Meszage summary for tfSSh

=] Woodstock Layout

7] rmiad Cummnl

Meszage summary for tfige

: lengthValidator1 - Properties I 2

Meszage summary for tHeight

Static Text

minimum 1

[=IGeneral
id lengthvalidator 1 E]

maximum 10

minimum

minimum {nt) minimwum

FIGURE 41.38

o

53]

You can specify the maximum and minimum properties for a TengthValidator.
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regular expression

regular expression
throw
ValidatorException

ValidatorException

implement Submit button

virtual form

create Ul

JSF and Visual Web Development

The format for SSN is ddd-dd-dddd, where d is a digit. You need to create a custom val-
idator and use a regular expression to validate a SSN. Right-click tfSSN in the Design, and
choose Edit Event Handler > validate to generate the method named tfSSN_validate in
the Java source page. Implement the method as follows:

public void tfSSN_validate(FacesContext context,
UIComponent component, Object value) {
String ssn = String.valueOf(value);

1
2
3
4
5 if (Issn.matches("[\\d1{3}-[\\d1{2}-[\\d1{4}")) {
6 throw new ValidatorException (new FacesMessage(
7 "Enter a valid SSN, e.g., 123-44-5678"));

8 1

9

}

The program checks whether the ssn is correctly formatted. If not, a ValidatorException
is thrown in line 6.

& Tip
Right-click on ValidatorException in the Editor pane to display a context menu and choose Fix Imports
to import javax.faces.validator.ValidatorException.

Similarly, you can write the code to ensure that age is an integer between 1 and 135 and
height is a double value between 2.0 and 10.0.
The Submit button can be implemented as follows:

1 public String btSubmit_action() {
stResult.setText("The inputs you entered are <br />" +
"Name: " + tfName.getText() + "<br />" +
"SSN: " + tfSSN.getText() + "<br />" +
"Age: " + tfAge.getText() + "<br />" +
"Height: " + tfHeight.getText() + "<br />");

return null;

3

OooNOuUVIhA~ WN

41.8 Virtual Forms

When you submit a form, all input components in the form participate in the submission.
However, not all these components are needed for a particular submission. For example,
when you click the Compute Loan button in the form in Figure 41.39, only the text fields
for loan amount, interest rate, and number of years need to be submitted. When you click
the Compute Body Mass Index button, only the text fields for weight and height need to be
submitted.

To improve efficiency, you may define a virtual form to group input components with a
submission component (e.g., a button or a drop down list with autosubmit enabled). The
input components participate in the virtual form. When the user interacts with a submission
component that submits a virtual form, the input components in the virtual form are submit-
ted while the other input components not defined in the virtual form on the page are ignored.

Let us build an application for Figure 41.39 using virtual forms. Create a new page named
VirtualFormDemo and create the user interface, as shown in Figure 41.40. The text fields
are named tfLoanAmount, tfAnnualInterestRate, tfNumberOfYears, tfWeight,
and tfHeight. Two buttons are named btComputelLoan and btComputeBMI. Two static
texts are named stLoanResult and stBMIResult. Add binding attributes for all text
fields and static texts.

We are going to create two virtual forms: one for grouping the components for computing
loan and the other for grouping the components for computing body mass index.

o
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File Edit View History Bookmarks Tools Help

(L1 |http:;'.."locaIhost:SUSU.."jsfdemDf’faceWirtuaIFormDemo.jsp

77 -]

Loan Amount: 100000
Annual Interest Rate: 7.15

Number of Years: 5

Monthly payment is 1987 2045267470833
Total payment is 119232 271604324559

»

Weight in Pounds: 145

Height in Inches: 72

m

Compie Body Mass Index |

BMlis 18.67

Done

File Edit View Navigate Source Refactor Run Debug Profile Team Tools Window Help
3 i 3 g i G - . T
EEY D T >B O =G |
iPr.. = | Files | Services ..ava |5] ValidateForm $|5] VirtualFormDemo * 52 | sun-web. xml $| E‘BE @ : Palette o 2
=-& isfdemo #|[Design ] ¢ zava | & & i [AnySize -] ) Woodstock Basic -
&L Web Pages |E| DD 1|43 Label =
: WEB-INF n e || LA static Text
resources . LoanAmwount: | 00 Weight in Pounds: o] ] Text Field
Computeloan.jsp : . . - . . ]
CurrentTime.jsp . .Annual InterestRate: | | © o : =] Text Area 1
H DisnlawStudent. isn bl . Humber of Years: || 0. . . Height in Inches: .. ... ||: stBMIRe=ult - Properties 0 =
! stBMIResult - Navigator am o S | [EGeneral o~
: [} |A] stloanResut Compute Loan Compute Body Mass Index | 1|id stBMIResult ]~
] thweight I T Ll ) |= Appearance
T tiHeight e o. . l..a B ] style position: ab... [[] *
= = Static Text Static Text 1
-[#] btC teBMI| = b
; l—‘l Ompu |_| S ey o o stB"“Result 9
taticText1 (StaticText
e B | S R S g . [P staticText1 (StaticText)
< | . . .
B o1 |ms

FIGURE 41.40 The user interface is created for computing loan and body mass index.

1. Ctrl-click to select tfLoanAmount, tfAnnualInterestRate, tfNumberOfYears, and
btComputelLoan. Right-click one of the selected components to display a context menu
and choose Configure Virtual Forms to display the Configure Virtual Form dialog box, as
shown in Figure 41.41(a). You should see tfLoanAmount, tfAnnualInterestRate,

@ Configure Virtual Forms

tloanAmount
thumberofyears
btComputeLoan
tfAnnuallinterestRate

These components participate in and submit virtual forms as follows:

@ Configure Virtual Forms

tf.oanAmount
tiumberOfyears
btComputeloan
tfAnnuallnterestRate

These components participate in and submit virtual forms as follows:

Calor Name Participats Submit Participate Submit
virtualForm1
QK | Cancel Apply | Help | Ok I Cancel | Apply | Help |
(a) (b)
FIGURE 41.41 You can create/delete/configure virtual forms.

o



M41_LIANO807_08_SE_C41.QXD 11/16/09 10:18 AM Page 41—28$

41-28 Chapter 41 JSF and Visual Web Development

tfNumberOfYears, and btComputeloan in the upper left corner in the dialog box. Click
the New button to create a virtual form named virtualForml. Choose Yes in both the Par-
ticipate and Submit columns, as shown in Figure 41.41(b).

2. Ctrl-click to select tfWeight, tfHeight, and btComputeBMI. Right-click one of the
selected components to display a context menu and choose Configure Virtual Forms to
display the Configure Virtual Form dialog box. You should see tfWeight, tfHeight,
and btComputeBMI in the upper left corner in the dialog box. Click the New button to
create a virtual form named virtualForm2. Choose Yes in both the Participate and
Submit columns, as shown in Figure 41.42.

® Configure Virtual Forms il

textField1

thireight

btEMI

These components participate in and submit virtual forms as follows:

Color | Name | Participate Submit | New |
i
Delete

’TI Cancel Apply | Help |

FIGURE 41.42 Two virtual forms are created.

Implement the handlers for the two buttons as follows:

public String btComputeLoan_action() {

double ToanAmount =

Double.parseDouble(tfLoanAmount.getText().toString().trim());

int numberOfYears =

Integer.parseInt(tfNumberOfYears.getText().toString().trimQ);
double annualInterestRate = Double.parseDouble(
tfAnnualInterestRate.getText().toString(Q).trimQ);

chapter4l.Loan loan =

new chapter4l.Loan(

annualInterestRate, numberOfYears, loanAmount);

stLoanResult.setText("Monthly payment is

+

loan.getMonthlyPayment() + " Total payment is " +

Tloan.getTotalPayment());

return null;

}

public String btBMI_action() {

final double KILOGRAMS_PER_POUND = 0.45359237;

final double METERS_PER_INCH

double weight
double height

double bmi =

= 0.0254;

Double.parseDouble(tfWeight.getText().toString());
Double.parseDouble(tfHeight.getText().toString());

weight * KILOGRAMS_PER_POUND /

(Cheight * METERS_PER_INCH) * (height * METERS_PER_INCH));

stBMIResult.setText("BMI is " + (int)Math.round(bmi

return null;

}

* 100) / 100.0);

Now you can run the program (see Figure 41.39). Clicking the Compute Loan button will sub-
mit the text fields for loan amount, annual interest rate, and number of years. Clicking
Compute BMI will submit the text fields for weight and height.

o
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& Note
Supplement V.F, “More on JSF and Visual Web Development,” provides additional examples on visual more supplemental examples
Web development, such as performing database inserts, updates, and deletes, and working with Ajax.

KEy TERMS

init 41-5 data binding 41-14
preprocess 41-5 palette window 41-3
prerender 41-5 UI container 41-11

destroy 41-6

CHAPTER SUMMARY

I. JSF enables you to use a visual design tool to develop UI for Web applications.

2. A JSF page has three tabs: Design, JSP, and Java. The Design tab enables you to visu-
ally design UI. The JSP tab enables you to view and modify the JSP script for the
page. The Java tab enables you to view and modify the page bean Java source code.

3. JSF uses the life-cycle methods init, preprocess, prerender, and destroy to
control the execution of a JSF page.

4. JSF contains Swinglike UI components. You can click and drop these components to
the Design pane to create UI.

5. JSF contains Grid Panel, Group Panel, and Layout Panel containers for grouping com-
ponents.

6. You can create a database connection from the Databases node in the Services pane
and bind database queries with JSF UI components.

7. You can perform session tracking using the SessionBean.

8. You can validate input to ensure that the required field has been filled and the input is
formatted correctly.

9. You can use virtual forms to group the participants of a form to improve efficiency.

REVIEW QUESTIONS

Sections 41.1-41.2
41.1 Whatis JSF?
41.2 How do you create a JSF project in NetBeans?

41.3 How do you create a JSF page in a JSF project?
41.4 Describe the life-cycle methods init, preprocess, prerender, and destroy.
41.5 Each JSF page has a .jsp file. What is in the JSP file? Can you modify it directly?

41.6 Each JSF page has a page bean file. What is in the page bean file? Can you modify
it directly?

Section 41.3

41.7 How do you set the initial value and display names in a drop down list and in a list box?
41.8 How do you specify radio buttons and their names in a radio button group?

41.9 How do you specify check box buttons and their names in a check box button group?
41.10 How do you hide a component so that it will not be displayed?

41.1l What method should be used to obtain the input from a text field or a text area?

o
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41.12 What method should be used to obtain the selected item(s) from a drop down list
or a list box?

41.13 Can you create two forms in one JSF page?

Section 41.4
41.14  What containers are available in JSF?
41.15  Ifthe order of the components in a container is not correct, how do you reorder them?

Section 41.5

41.16  How do you create a database connection?

41.17 How do you create a data provider?

41.18 How do you modify a row set?

41.19 How do you create a table and bind a data provider with the table?

Section 41.6

41.20 How does JSP implement session tracking?

41.21 How do you create a JavaBeans property?

41.22  How do you obtain a JavaBeans property in the page bean file?

Section 41.7

41.23  What component can be used to automatically display the error message if in-
valid input is entered?

41.24 How do you set a Message component to associate with an input component?

41.25 What property for an input component should be checked to specify that an
input is required?

41.26  How do you check the format of input using regular expressions?

PROGRAMMING EXERCISES

41.1%  (Factorial table in JSF) Rewrite Exercise 40.1 using JSF. Drop a Static Text to
display the result. Set its escape property to false to display it as HTML contents.

41.2*%  (Multiplication table in JSP) Rewrite Exercise 40.2 using JSF.

41.3*%  (Calculator) Write a calculator to perform addition, subtraction, multiplication,
and division, as shown in Figure 41.43.

2 http://localhost:8080/jsfdemo/faces/Exercise41_3.jsp - Windows Internet EXp - |EI il
@O hd |g. http://localhost: 8080/jsfdemo/faces/Exercised1_3.jsp j |£| |g‘ |Google \p v|
Lo ¥ @ hup:/focahost:8080/jsidemoffaces/Exer... | | J fi ~ B - = v rpage~ GiTookv

[

Number 1: |4 Number 2: |5 Result: |9

[ Aca | | suptract | | mutiply | | Dwide |

H

FIGURE 41.43 This JSF application enables you to perform addition, subtraction,
multiplication, and division.

41.4*  (Calculating tax in JSP) Rewrite Exercise 40.4 using JSF.

41.5%  (Multiple-question opinion poll) Rewrite Exercise 40.13 using JSF.
41.6*  (Addition quiz) Rewrite Exercise 40.14 using JSF.

41.7*%  (Subtraction quiz) Rewrite Exercise 40.15 using JSF.

41.8*%  (Guessing birth date) Rewrite Exercise 40.16 using JSF.

41.9%  (Guessing the capitals) Rewrite Exercise 40.17 using JSF.
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